Training Center 4

Foundations: Facilitating Online Training

Participant Guide
Training Center 4
Foundations
Facilitating Online Training
Participant Guide
Project Team

Instructional Designer: Sarah Ryan-Roberts
Training Delivery Expert: Nina Daya

Disclaimer and Copyright

WebEx Communications, Inc. reserves the right to make changes in the information contained in this publication without prior notice. The reader should in all cases consult WebEx Communications, Inc. to determine whether any such changes have been made.

COPYRIGHT (C) 2006 WEBEX COMMUNICATIONS, INC. ALL RIGHTS RESERVED. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHTS LAW OF THE UNITED STATES. USE OF A COPYRIGHT NOTICE IS PRECAUTIONARY ONLY AND DOES NOT IMPLY PUBLICATION OR DISCLOSURE.

OTHER PRODUCT OR BRAND NAMES ARE TRADEMARKS OR REGISTERED TRADEMARKS OF THEIR RESPECTIVE OWNER.

THIS DOCUMENT MAY CONTAIN REGISTERED OR UNREGISTERED THIRD PARTY TRADEMARKS.

THIS DOCUMENT CONTAINS PROPRIETARY AND CONFIDENTIAL INFORMATION OF WEBEX, INC. AND/OR ITS SUPPLIERS. USE, DISCLOSURE, OR REPRODUCTION IS PROHIBITED WITHOUT THE PRIOR EXPRESS WRITTEN PERMISSION OF WEBEX, INC.

WEBEX AND THE WEBEX LOGO ARE REGISTERED TRADEMARKS OF WEBEX COMMUNICATIONS, INC.
# Table of Contents

## About the Course
- Purpose
- Audience
- Logging In
- Using this Manual

## Introduction
- Course Goals
- Course Objectives
- Tools You Can Use
- Summary

## Lesson 1: Building a Foundation
- Training Session Window
- Understanding Roles
- Attendee Privileges
- Summary
- Check Your Understanding

## Lesson 2: Communicating with Participants
- Participants Panel
- Chat Panel
- Q&A Panel
- Summary
- Check Your Understanding

## Lesson 3: Presenting in a Training Session
- Share Features
- Sharing Presentations & Documents
- Sharing an Application
- Floating Panels
- Sharing Your Desktop
- Share Whiteboard & Annotations
- Sharing Web Content
- Sharing a Web Browser
- My Training Manager
- Summary
- Check Your Understanding

## Lesson 4: Polling
- Polling Panel
About the Course

Purpose

*Training Center 4 Foundations: Facilitating Online Training* is part of our “Using WebEx with Confidence” series. In this class, you will gain skills that enable you to conduct training sessions in a highly interactive environment to ensure your participants are engaged and get the maximum benefit from your class. Through demonstrations and hands-on practice, you will learn how to present information in an online setting as well as how to communicate with your audience. To reinforce your new skills, practice exercises provided for completion after the class will reinforce your new skills.

Audience

The target audience for this course is trainers who will be conducting online training in WebEx Training Center.

Prerequisites

- Basic understanding of computers and Windows operating system.
- Familiarity with the Internet and the use of Web browsers.
- Training Center JumpStart! class or equivalent knowledge.

Logging In

To log in to the training session:

1. Open a browser window.
3. Locate the course name and click on the link provided.

Minimum System Requirements

- Microsoft Windows 2000 or XP.
- Intel Pentium 166 MHz or faster processor.
- 32 MB RAM (64 MB Recommended).
- Microsoft Internet Explorer 4.x or later, Netscape Navigator 4.x, or AOL 5.0 or later.
- JavaScript and cookies enabled on the Web browser; ActiveX enabled on Internet Explorer
- 56K or faster Internet connection.
- For Internet Phone (VoIP), appropriate sound card plus microphone and speakers.
Using this Manual

This course will include discussions, demonstrations of step-by-step procedures, and interactive exercises designed to give you hands-on practice. Throughout this guide, you will also find tips on best practices and notes containing additional information or cautions. The icons listed below identify the kind of information being presented.

<table>
<thead>
<tr>
<th>CONVENTION</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Head Icon]</td>
<td>This icon indicates a discussion topic.</td>
</tr>
<tr>
<td>![Feet Icon]</td>
<td>This icon indicates a demonstration of a step-by-step procedure.</td>
</tr>
<tr>
<td>![Feet Icon]</td>
<td>This icon indicates an opportunity to practice what you have learned by completing an exercise.</td>
</tr>
<tr>
<td>![Check Mark Icon]</td>
<td>This icon indicates an opportunity to check your understanding by answering review questions.</td>
</tr>
<tr>
<td>Select Menu Name &gt; Menu Item</td>
<td>This text indicates a navigation path to execute a command on the menu bar.</td>
</tr>
<tr>
<td>Click Button Name</td>
<td>This text indicates clicking on a button or icon.</td>
</tr>
</tbody>
</table>

Participant Guide Overview

Whether you downloaded this participant guide before attending class or received it as a file transfer at the end of class, it will serve you as a valuable resource.

Using the bookmarks feature in this PDF document, you can easily navigate to the topics you want. You can also search for words or phrases throughout the manual. This document is designed to be printed double-sided. Below are a few pointers to help you use it efficiently.
To Navigate the Document

1. If the PDF did not open with the Bookmarks showing, click the Bookmarks tab.

2. To expand a topic, click on the + sign to the left of the heading.

3. To go to a topic, click the topic title and you will be linked to that topic in the manual.

To Search the Document

1. Click on the Search button on the Toolbar or from the Edit menu select Search.
2. Enter text in the What word or phrase would you like to search for? text box.
3. Click Search.

The Search Results appears.

4. In the Results box, click a link to navigate to the corresponding text in your document.
5. To search on another word or phrase, click New Search.
Introduction

Course Goals

Facilitating Online Training is designed to make you a confident presenter in a WebEx Training Center session. Through demonstrations and hands-on practice, you will gain the necessary skills to share content in a training session as well as interact with participants. To reinforce your new skills, a practice exercise is provided for completion after the class. A certificate of completion is provided at the end of the class.

Course Objectives

At the end of this course, you will be able to:

- Navigate the Training Center window
- Identify the roles in a training session
- Assign attendee privileges
- Interact with participants in a training session
- Present in a training session
- Create and conduct polls

How will we do it?

1 **Presentation:** We will discuss the topics presented in the course.

2 **Demonstration:** We will go through the steps to complete each task.

3 **Hands-On Practice:** You will have the chance to practice what you have learned.
Tools You Can Use

Throughout the session, you will have the chance to ask questions and participate in discussions and exercises. You will be using Raise Hand, Chat, and Annotation features.

To Ask a Question

1. Click Raise Hand.

2. The Raise Hand icon will appear next to your name in the Participant’s list for the Host and Presenter.

OR

1. Type your question in the Chat box and click Send.
Tools You Can Use

To Mute Your Line

1. Select your name in the participant list.
2. Click the Mute button.
   
   **Note:** This button toggles between mute/unmute. Click it again to unmute your line.

OR

1. On your telephone keypad, press the Star key (*) plus the number 6.
2. To unmute your line, press the same keys (*6).

To Reconnect to the Session

1. *If you are disconnected from the training session*, refer to your confirmation email for the link to the site and other pertinent information for reconnecting.
2. *If you are disconnected from the teleconference*, click on the Info tab above the Content Viewer window to display the teleconference number you need to dial.

Summary

Now that you know some basic tools for participating in the session, let’s get started.
Lesson 1: Building a Foundation

In this lesson, you will learn how to:

- Navigate the training session window
- Identify the roles in a training session
- Change roles of attendees
- Assign attendee privileges

Training Session Window

The Training Center session window provides options for session participants to communicate - including chat, sending and receiving questions and answers, providing feedback, and sharing presentations and other information. In this lesson, we will tour the training session window and describe the various components.

The Training Center session window consists of four main areas:

- Menus
- Toolbars & Status Bar
- Content Viewer
- Panels

Menus

Toolbars

Panels

Content Viewer
Menus
The menu bar contains many of the functions that the host needs to conduct a successful training session. Some commands are available only to the host or presenter during a training session. Other commands can be activated for the participants by the host. Some commands on the Menus are duplicated as Tools on the Toolbar. Many of the commands have keyboard shortcuts. The following menus are available:

- **File menu** provides commands for saving, opening, transferring, or printing files during a training session. You also leave or end a training session from this menu.
- **Edit menu** provides commands to edit shared content and set personal preferences.
- **Share menu** provides commands for sharing documents, presentations, applications, Web browsers, desktops, remote computers, multimedia Web pages, and whiteboards.
- **View menu** provides commands to control how information is displayed in the content viewer, including use of the Quick Start feature. Panels can also be controlled from here as well.
- **Communicate menu** provides commands to use communication tools, such as joining or leaving a teleconference and Integrated VoIP.
- **Participant menu** provides commands to mute or unmute attendees, set privileges, and change the role of an attendee.
- **Session menu** provides commands for training session options, recording features, and restricting access.
- **Breakout menu** provides commands to enable breakout sessions as well as start, join and leave those sessions.
- **Help menu** provides access to online help as well as the version of Training Center you are using.

Toolbars & Status Bar
The toolbars and status bar are divided into four main sections.

You can use these to:

- Share presentations and documents, applications, your desktop and whiteboards.
- Annotate documents with a highlighter, text tool, and various drawing tools; also move forward and back through your presentation or document.
• Control the display of your content with standard, thumbnail, and full-screen views.

• Check the status bar for information on recording, teleconference numbers, and your session information number.

Sharing Icons

Icons L-R: Share document, application, desktop, whiteboard

Annotation/Presentation Tools

Icons L-R: Pointer, Text, Line, Rectangle, Highlighter, Annotation Color, Eraser, Previous Page, Next Page

View Tools

Icons L-R: Standard, Thumbnails, Rotate Page Left, Rotate Page Right, Full-Screen, Zoom In, Synchronize Displays for All

Status Bar

The recording indicator appears if your training session is being recorded. The attendee ID and teleconference information appear when you are disconnected from the teleconference.

Icons L-R: Recording On indicator, training session number, attendee ID, Teleconference information.

When you are connected to the teleconference, your status bar looks like this.

Content Viewer

The content viewer displays documents, presentations, whiteboards and Web content that you wish to share during a training session. Document tabs at the top of the viewer allow you to switch among the various types of content. You can change the tab order for con-
tent you share by dragging the tab to the new location. Double-click a tab label to rename it.

The Info tab, displayed by default, lists the session topic, number, teleconference information, and host key or attendee ID. The Quick Start tab, if enabled, gives presenters quick access to sharing documents, applications and desktop.

Panels
The session window panels are located on the right side of the Training Center session window. The panels allow you to interact and collaborate with other participants in the session. The following panels are available in Training Center:

- **Participants** panel displays the participant list and provides feedback tools for communicating with the presenter.
- **Chat** panel provides text communication with other participants, both as a group and privately.
- **Q&A** panel allows for structured text communication between the host, presenter & panelists and attendees.
- **Breakout Sessions** panel provides options for managing breakout sessions.
- **Testing** panel allows you to administer tests that were pre-loaded before the start of the session. If no tests are loaded, this panel title is greyed out.
- **Polling** panel gives the presenter the ability to create a poll and displays the poll for participants.
- **Video** panel displays live video of the current presenter. If multi-point video is enabled, up to four video images will display.
Navigating Around

1. Start a practice session from your Training Center site.
2. From the Help menu select Training Session Help.
3. Click on the Glossary link to view a full listing of Training Center terms. Close the Help file when you are finished.
4. Click on the Share menu and view its commands.
5. Click on the Share Whiteboard icon on the toolbar. Switch between the Info tab and the Whiteboard tab.
6. Collapse the Chat panel. Maximize the Q&A panel.
7. Select Reset to Default from the Panel View drop-down menu.

Understanding Roles

There are four roles in a Training Center session. A training session **host** is responsible for coordinating and controlling a training session. The **presenter** is responsible for presenting content during the session. In addition, there is the **panelist** who may assist the presenter, and the **attendee** who is the learner. These roles, together, comprise the total participants in a Training Center session. Multiple roles can be shared by one individual. For instance, a host could also serve as a presenter. All people in the training session, collectively, are known as **participants**.

**Host**

The host of a training session can be compared to a training administrator or training coordinator. The host must have a WebEx user account. The host is a user who:

- Schedules and/or starts and ends a training session.
- Controls participant access to the training sessions and teleconference.
- Designates the current panelist and presenter.

Initially, the training session host is also the presenter. The host can designate any attendee as the current presenter and will also assign any panelists.
**Presenter**
The presenter in a Training Center session can be compared to the training session instructor. A presenter may or may not have a WebEx user account, but is a training session participant who presents information to other training session attendees. A presenter is able to share documents, presentations, applications, Web browsers, the computer's desktop, and information on a whiteboard with others. In addition, the presenter can:

- Create and administer polls.
- Provide answers during a Q & A session.
- Make changes to training session options.
- Set attendees privileges.
- Assume the Host role, if designated by the host.

**Panelist**
A panelist can be compared to a subject matter expert or a co-instructor. A panelist is assigned the panelist role by the host. A panelist might serve, for example, as the “subject matter expert” for a breakout session or question-and-answer (Q & A). During the session the panelist can:

- Share presentations or whiteboards.
- Field questions asked by training participants using Q&A.
- Address discussion items directed specifically to the panelist using Chat.

**Attendee**
An attendee in a training session can be compared to a student or learner. An attendee is a training session participant who views information shared by the presenter, but is not a host, panelist or presenter. Shared information includes documents, presentations, applications, Web browsers, the presenter's desktop, and information on a whiteboard. An attendee, when assigned the appropriate privileges by the presenter, is able to:

- Annotate on shared information.
- Participate in features such as Chat, Q & A, and Testing & Polling.
### Summary of Roles & Responsibilities

<table>
<thead>
<tr>
<th></th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Session &amp; Teleconference</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manages Registration</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starts &amp; Ends Session</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Registers/Joins a Session</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Assigns Attendee Privileges</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Creates/Starts Breakout Sessions</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Uses Share Menu</th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creates/Opens Test &amp; Polls</th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manages Chat and Q&amp;A</th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Joins Breakout Sessions</th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Annotates</th>
<th>Host</th>
<th>Presenter</th>
<th>Panelist</th>
<th>Attendee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

---

### Changing Roles

To make an Attendee a Panelist or Presenter:

1. From the Participants panel, select the person’s name by clicking on it with your mouse.

2. Click the Make Presenter button. The person’s name will appear under the Panelists list and the name will also appear as Presenter.
To change roles from the Participant menu:

1. Click the name of the person in the Participants panel for whom you wish to change roles.

2. From the Participant menu, choose Change Role To.
   
   **Note:** You can access the same Change Role To command by right-clicking on a participant’s name in the Participant panel.

3. Select Presenter, Panelist, Attendee, or Host.
   
   **Note:** If you reassign the Host role and it is not returned to you, the only way to retrieve it is to select Reclaim Host role from the Participant menu and enter your Host Key. Be sure to write down this number from the Info tab before you give up your role as host.

**Attendee Privileges**

During a Training Center session, the presenter can grant certain privileges to attendees to allow for more participation and interaction during the training session. In general, an attendee participates in a training session, but does not present information. The presenter can grant certain privileges to attendees to allow for more
interaction during the training session. For example, the presenter can allow attendees to:

- Share documents or presentations.
- Annotate shared documents, presentations, and whiteboards.
- Remotely control shared applications, Web browsers, and desktops.
- Start or participate in breakout sessions.
- Provide feedback to the presenter.
- Save documents, presentations, and whiteboards in the content viewer.
- Display different views of pages, slides, and whiteboards in the content viewer for example, full-screen view or thumbnail view.
- Record a training session.

**Granting Attendee Privileges**

1. Right-click the Participant panel title bar and select **Assign Privileges**.

   ![Assign Privileges](image)

   OR

1. Select **Assign Privileges** from the **Participant** menu.
2 Check the box next to the privilege that you want to give to the attendees. If you wish to grant all privileges to attendees, check the box next to All Attendee Privileges.

3 Click Assign.

Note: Attendee privileges are granted to all attendees.

**Passing the Ball**

1 In a practice training session, invite at least one attendee. For more fun, invite two people.

2 Share a PowerPoint presentation.

3 Select one of your attendees and click on the Make Presenter button to make him or her the new Presenter.

4 Have the new Presenter click on Full Screen.

5 Ask the new Presenter to advance your slides then return to the beginning.

6 Press the ESC key to return to Standard view. Close the confirmation dialog box.

7 As the Host, click on your name and click the Presenter ball to resume control of the presentation.
**Summary**

In this lesson, you learned how to navigate in the Training Session window using the menu bar, toolbar and panels. You also learned about the various roles participants can assume in a Training Session and the tasks they can control within each role. And finally, you learned to assign attendee privileges in your session.

In lesson 2 you will learn about various ways to communicate with participants in your training session. Before moving on, be sure to check your understanding of lesson 1 by answering the questions that follow. The answers are provided on the reverse side of the Check Your Understanding page.
Check Your Understanding

1. Where are shared presentations and documents displayed?
2. How do you move forward and backward through a presentation or document?
3. Who is able to change the role of another participant?
4. Who can grant privileges to attendees?
### Answers to Lesson 1

1. Where are shared presentations and documents displayed?
   - **Content viewer**

2. How do you move forward and backward through a presentation or document?
   - **Next/previous arrows on the annotation/presentation toolbar**

3. Who is able to change the role of another participant?
   - **Host**

4. Who can grant privileges to attendees?
   - **Presenter**
Lesson 2: Communicating with Participants

In this lesson, you will learn how to:

- Select appropriate Feedback tools
- Send Chat messages both publicly and privately
- Send and answer questions using Q & A

Participants Panel

The Participants panel allows you to view the list of all participants in a training session. When an attendee joins a training session, the attendee's name appears on the participant list. The list is grouped by panelists and attendees. Optionally, you can sort the list in ascending or descending order by clicking on the arrow to the right of the Name label.

If the training session includes an integrated teleconference, a telephone symbol appears to the left of the name of each attendee who is connected to the teleconference. If the training session includes an Integrated VoIP conference, a microphone appears to the left of the name of the attendee who joined with Integrated VoIP.

Participant Panel Symbols

<table>
<thead>
<tr>
<th>Description</th>
<th>Status</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teleconference</td>
<td>Unmuted</td>
<td>Muted</td>
</tr>
<tr>
<td>Integrated VoIP</td>
<td>Current Speaker</td>
<td>Muted</td>
</tr>
</tbody>
</table>

Foundations: Facilitating Online Training
Note: A training session host or presenter can specify whether attendees can see the names of all attendees in the participant list when assigning Attendee Privileges.

Feedback Tools
Feedback buttons, which allow participants to give non-verbal feedback to the presenter during a training session, appear at the bottom of the Participant panel. For example, participants may select the “Yes” or “No” icons when prompted with the question, “Are we ready to move on to Breakout Sessions?” Additionally, when this Training Session option is turned on, a participant may choose to flag the presenter with a “Go Faster” or “Go Slower” response. This lets the presenter know that a change in pace may be needed. The Feedback toolbar also includes emoticons. Raise Hand allows participants to request to speak during a training session.

Order of Buttons: Raise Hand, Yes, No, Go Faster, Go Slower, Emoticons, Feedback Results, Clear Feedback

Once feedback is cleared by the Presenter, additional feedback can be conducted during the course of the training session. As a default, Feedback is turned on. Feedback is not anonymous and responses can be changed during the session.

Using Feedback Tools

1. Click on one of the Feedback buttons at the bottom of the Participants Panel. Your response will appear on the Participants panel in the Feedback column.
2 To request to speak in a session, click **Raise Hand**. The **Raise Hand** icon appears next to your name.

**Chat Panel**

The Chat feature provides an alternative means of communication that can be used in conjunction with, or in the absence of, a teleconference. The **Chat Panel** displays chat messages exchanged between participants.

You can send chat messages to various combinations of participants (e.g., All Participants; Host & Presenter; Host, Presenter & Panelists; All Panelists; All Attendees; or privately to an individual). To send a chat message, simply type your message in the chat box at the bottom of the panel, select the message recipient is for from the **Send to** drop down list, then click Send.

**Q&A Panel**

Q&A sessions provide an opportunity for attendees to ask questions and receive answers from the training session host, presenter and/or panelist. Q&A is similar to chat, however it uses an alternative format to provide a more structured means of asking and answering questions. Click the Q&A button in the Icon Tray to maximize the panel if it is now showing.
**Lesson 2: Communicating with Participants**

---

### Asking & Answering Questions

**To ask a question:**

1. Type a question in the box above the **Ask** button in the Q&A Panel.
   - **Note:** If your Q&A Panel is not active, click on the Q&A button in the Icon Tray at the top of all panels.

2. Select from the **Ask** drop-down menu the person to whom you wish to direct your question.

3. Click **Send**. Your message will be sent and appears on the Q&A panel of the receiver. Other attendees don’t see your question until it is answered.

---

**Note:** The Q&A icon turns orange for panelists when a question is asked and the panel is minimized.
To answer a question:
1. Select the question by clicking on it with your mouse. *The question you have selected appears highlighted.*
2. Type an answer in the box above the **Send** button.
3. Click **Send**. Your answer appears below the question in the Q&A Panel for all attendees.

![Q&A Panel](image)

**Note:** The person who asked a question will see the answering indicator with the words “This question is being answered...” when a panelist is typing a response to their question.

To answer a question privately:
1. Select the question by clicking on it with your mouse. The question you have selected appears highlighted.
2. Type an answer in the box above the **Send** button.
3. Click the **Send Privately** button. Your message appears in the Custom Response box. If you wish, you may modify your message further.
4 To defer the question, choose Defer. The following message will be sent:

“Thank you for your question. Your question was deferred but will remain in the queue. A panelist will answer your question at a later time.”

5 To dismiss the question, choose Dismiss. The following message will be sent:

“Thank you for your question. The information that you requested cannot be provided by any of the panelists.”

6 To send a custom response, choose Custom. Type the custom response in the field.

7 Click Send.

Note: You can also right-click the question and select Defer or Dismiss from the pop-up menu.

Interacting Non-Verbally

1 Ask attendees in your training session to enter the name of the city where they were born in the Chat area.

2 Inform attendees they can use the Q & A panel to ask you a personal question about your background. Remember if it is too personal, you can always dismiss it.

3 Ask the attendees to use the Raise Hand feedback tool if they have any more questions.

Summary

In this lesson, you learned about the communication features inside a training session. Specifically, you learned how to use the Participants Panel, including Feedback tools, as well as the Chat, and Q&A Panels. Keeping your training sessions lively with good feedback tools is easy in Training Center.

In lesson 3 you will learn about various ways that you can present information in the training session. Before moving on, be sure to check your understanding of lesson 2 by answering the questions that follow. The answers are provided on the reverse side of the Check Your Understanding page.
1. Name two options for providing non-verbal feedback to the presenter.
2. How can you ask a question during a training session?
3. If the Q&A Panel is minimized or collapsed and someone asks you question, how would you know?
4. What could you do to help answer questions during your training session?
Answers to Lesson 2

1. Name two options for providing non-verbal feedback to the presenter.
   
   Raise Hand, Yes, No, Go Faster, Go Slower, Emoticons

2. How can you ask a question during a training session?
   
   Q&A or Chat

3. If the Q&A Panel is minimized or collapsed and someone asks you question, how would you know?
   
   The Q&A Icon will turn orange.

4. What could you do to help answer questions during your training session?
   
   Assign a Panelist to assist.
Lesson 3: Presenting in a Training Session

In this lesson, you will learn how to:

- Share Presentations and Documents
- Share Applications with Remote Control
- Share your Desktop
- Share a Whiteboard and Use Annotations
- Differentiate between Share Web Content and Web Browser
- Use Share My Training Manager

Share Features

The Share Features are really the heart and soul of the Training Center session. Sharing allows everyone in the training session to view the same content, just like in a physical classroom setting. You can share documents, whiteboards, applications, and information on the Web. You can also display the desktop of your own computer; or, if you wish, share My Training Manager, which allows participants to “look over your shoulder” in the training session. Many shared items can be printed or saved from the File menu.

While sharing, you can collaborate on projects by passing control of shared content to another participant. For example, the Share Application feature enables multiple people to edit the same document by passing control from one person to another. While whiteboards allow for simultaneous interaction if enabled by the presenter. Whiteboards can be used just like flip charts or whiteboards in a physical classroom - you can write up a quick agenda, table items for later, or simply record brainstorming ideas.

Sharing Access

Sharing features can be accessed in several ways. The most traditional method is from the Share menu on your menu bar. All Share features are available here, in addition to keyboard shortcuts for the most common items. A sharing toolbar in the top left corner of the window ensures quick access to the most popular sharing options as well.
Quick Start
The easiest method for sharing for beginners is Quick Start. If you are a presenter, it appears as a tab above your Content Viewer in the session window. In addition to being easy to use, this view also offers short explanations of the features including Learn More links which quickly take users to associated Help files.

Note: You can close the Quick Start window by clicking Quick Start. To reopen Quick Start, select Open Quick Start from the View menu.

Sharing Scenario
Now we will explore the similarities and differences among the various Share options. We will use the following business scenario to create a context for learning the Share features of Training Center.

You are the head of training for Remarkable Robots, a national company specializing in robots for the home market. You will be conducting an online employee orientation session using Training Center.

Sharing Presentations & Documents
Training Center has many options for hosts and presenters to engage attendees in the session. Presenters can share one or more documents or presentations, such as a document created using a word processing, presentation, or graphics program.
Generally, you can share any document or presentation that you can print. Attendees can view the shared document or presentation in their content viewers, even if they don’t have the application with which it was created installed on their computers. Presenters can share presentations to support the lessons in their training sessions, homework assignments, job aids or other documents. Attendees can also view any animation and transition effects on shared Microsoft PowerPoint slides. Shared presentations and documents can also be printed and saved from the training session window.

**To Share a Presentation or Document**

1. Select Share Presentation or Document from the Share Menu, Share Toolbar or Quick Start tab. The Share Presentation or Document dialog box appears.

2. Select the presentation or document to share.
   
   **Note:** If you don’t see your document listed, be sure Files of Type is set to All Files.

3. Click Open. The presentation or document will display in the content viewer and all attendees can view it.

4. Click Next Page to advance to the next page or slide; click Previous Page to view the previous page or slide.

5. To print the document or presentation, from the menu bar, select File.


7. Click Print.
Lesson 3: Presenting in a Training Session

8. To save a copy of a shared Document or Presentation, from the menu bar, select **File**.

9. Select **Save**, and choose **Document**.

10. Browse to the location to save the file.

11. Type a name for the file in the **File name** field.

12. Click **Save**.

   **Note:** The document is saved as a .ucf (Universal Communication Format) file. The file can be opened outside of the Training Center environment by downloading the UCF player.

---

**Sharing an Application**

Sharing an application allows all training session attendees to view the actions that the presenter takes in an application. The attendees do not need to have the application installed on their computers. Attendees can also view any animation effects in a shared application. Application sharing is useful if you want to demonstrate software, edit documents, or train attendees on using an application.

While sharing an application, you can allow an attendee to control it remotely. For example, if you share a Microsoft Word document, you can allow an attendee to edit the document on your computer. This is a good way to give attendees hands-on practice using an application. You can also annotate on an application or any document that you open in the application, and share annotation control with attendees.

**Note:** It is recommended that the presenter's screen resolution be set to the lowest setting that will be used by any participant in the session. In most cases, the optimum resolution setting is 800x600. This will ensure that participant’s are viewing the entire application.

---

**Floating Panels**

When you initiate Application or Desktop Sharing, or view any content in Full-Screen mode, you will see a floating panel toolbar. This enables you to see an enlarged view of your content while still maintaining access to your panels.

**Icons L-R:** Move Tray, Return to Main Window, Participant Panel, Chat Panel, Q&A Panel, Video Panel, Polling Panel, Breakout Session Panel, & View Panel.
If anyone tries to communicate with you through one of your panels, the panel icon will turn orange and flash. In addition to accessing your panels, you can also move the icon tray anywhere on your screen. You can click the left arrow to return to the main window at any time.

To Share an Application

1. Select **Share Application** from the Share Menu, Share Toolbar or Quick Start tab. The **Share Application** dialog box appears.
2. Select the application that you want to share and click **Share**.

![Share Application dialog box]

**Note:** It is recommended that you open the application before you share it. If you do not have the application open, click the button for **New Application**. All applications on your computer will be displayed in the dialog box.

To annotate on the Application:

3. From the **Sharing** menu, choose **Start Annotation**. The Annotation toolbar appears at the bottom of the screen and the menu appears in the top right corner.

![Annotation toolbar]

4. Select a tool and click in your application to use.
To allow attendees to annotate the application:

1. The attendee selects **Request Annotation** from the **Sharing** menu. The presenter receives a prompt that the attendee is requesting annotation privileges.

2. The presenter selects the attendee’s name from the **Allow to Annotate** command on the Annotating menu.

3. The Annotation Tools appear on the attendee’s screen.

To allow a participant to control the application:

1. Click the **Sharing** button in the top right corner of the application.

2. Select **Allow to Control Remotely**.

3. Select the participant’s name. The participant views a prompt to click on the application to gain control of it. The presenter can regain control of the application by clicking on the application.
To stop sharing the application:

1. Click the Sharing button in the top right corner of the application.
2. Select Exit Application Sharing.

Teaching a Lesson

1. Share a PowerPoint presentation with slides that outline a simple lesson with a Course Objectives slide (*You can always use New Employee Orientation.ppt and use the Agenda slide*).
2. Share an Application and demonstrate how to do something simple (*If you are working with the New Employee scenario, open a simple drawing program, and draw a simple robot*).
3. Pass control to an attendee and have them perform the same steps.
4. Resume control then turn on the Annotation tools so you can annotate with suggestions.
5. Allow the attendee to annotate. Tell him or her to take a snapshot of the artwork if they like.
6. Exit application sharing.

Sharing Your Desktop

Unlike sharing an application, where the participants’ view of your computer is limited, sharing your desktop allows all participants to view everything on your desktop.

Sharing your desktop allows all training session attendees to view your entire desktop, including any applications and windows that are currently open. Participants can view all the actions that you take with your desktop and applications. However, if your desktop has any background images, patterns, or wallpaper, your training session client software will remove them from attendees’ views to improve the performance of desktop sharing.

While sharing your computer's desktop, you can allow an attendee to control it remotely. This option can be useful for training participants on the use of a computer operating system, or training technical support representative to diagnose computer problems. For example, you can allow a technical support representative to access
your computer and fix a problem as you watch. You can also annotate your computer's desktop and share annotation control with attendees.

Sharing a desktop allows all session participants to view the presenter’s entire desktop and all interactions with the desktop.

**To Share a Desktop**

1. Select **Share Desktop** from the Share Menu, Share Toolbar or Quick Start tab.

2. The **Sharing** menu appears in the top right corner of your screen and the Floating Panels toolbar appears at the bottom.

   **Note:** Close and Exit Desktop Sharing, a new icon, appears on this toolbar.

**To grant remote control of a Desktop to another attendee:**

1. From the Sharing menu select **Allow to Control Remotely**.

   **Note:** You can also access the Sharing menu by clicking the WebEx ball on your computer’s taskbar.

2. Select the attendee to whom you want to grant remote control.

   **Note:** An attendee who has remote control of your desktop can run any programs and access any files on your computer that you have not protected with a password. Once the attendee assumes control, your mouse pointer is no longer active.
To resume remote control of a Desktop:

1. On your computer's desktop, click your mouse. You can now control the shared desktop.

   **Note:** The attendee who was controlling the shared desktop can reassume control at any time by clicking his or her mouse.

To prevent an attendee from further controlling a shared Desktop:

1. Click the **Sharing** button in the top right corner of your screen or click the **Sharing** button in the bottom right corner.

2. Point to **Allow to Control Remotely** on the Sharing menu. A menu appears, containing a list of all attendees in the training session. A check mark appears to the left of the attendee who has remote control.

3. Choose the attendee's name to deselect it. You can now control the shared desktop.

To stop Desktop Sharing:

1. From a Sharing menu select, **Stop Desktop Sharing**.

   **Note:** You can also click the Close and Exit Desktop Sharing icon from the Floating Panels toolbar.

---

**Share Whiteboard & Annotations**

In addition to sharing presentations and documents in a training session, the presenter also has the option of sharing a whiteboard. The presenter and attendees (if they have been granted the privilege) can draw and type on the whiteboard.

Sharing a whiteboard in Training Center is just like using a whiteboard or flip chart in a classroom setting. Whiteboards can be used for brainstorming and other collaborative activities. Presenters can also use a whiteboard to list session ground rules, or record ideas in a “parking lot” for later discussion. A whiteboard can also be printed or saved.
Lesson 3: Presenting in a Training Session

To Share a Whiteboard

1. In the Session window, on the Share menu, choose Whiteboard. A whiteboard will display in the content viewer as a new tab.

   ![Whiteboard Menu](image)

   **Note:** You can also click the Share Whiteboard icon on the Sharing Toolbar.

Using Annotation Tools

To draw on a Whiteboard:

1. Select a drawing tool from the toolbar. If a tool has a drop-down arrow to the right of it, it means there are more options for the tool.

2. Select a color from the Annotation Color palette.

3. Position your cursor on the whiteboard and click to draw.

To type text on a Whiteboard:

1. Select the text tool from the toolbar.

2. Select a color from the Annotation Color palette if you wish to change the default color.

3. To change your font, choose Font from the Edit menu then click OK.

4. Position your cursor on the whiteboard and click to type.
5 Type some text and click with your mouse.
   **Note:** Other participants cannot see what you type until you click with your mouse.

6 Click on the Eraser tool and click on the text if you wish to erase it.

7 To erase all your annotations, from the Eraser drop-down list select **Clear My Annotations**.
   **Note:** If you are the presenter, you can also select **Clear All Annotations** to clear all annotations from the screen.

**To add a page to a Whiteboard:**
1 Be sure your Whiteboard tab is active.
2 From the **Edit** menu select **Add Page**. Your presentation toolbar will increment by one.

**To print a Whiteboard:**
1 From the **File** menu select **Print**.
2 Choose **Document** then click **Print**.

**To save a copy of a Whiteboard:**
1 From the **File** menu select **Save** then choose **Document**.
2 Browse to the location to save the whiteboard.
3 Type a name for the whiteboard in the **File name** field.
4 Click **Save**.

**Sharing in the Content Viewer**
1 If you closed the presentation you shared earlier, share it again.
2 Share a whiteboard and type the title Summary using your text tool.
3 Switch to the presentation and advance through all your slides then switch back to the whiteboard.
4 Ask attendees one at a time to use the text tool to type one key point of the presentation on the whiteboard. *Be sure you have granted attendees annotation privileges.*
5 Select a drawing tool and mark or highlight each point as you discuss it further.
6 Clear all annotations when you are finished.
Sharing Web Content

Sharing Web Content allows all participants to view a Web page and interact independently with it as if they were navigating on their own computers.

Sharing Web content opens a browser on each participant’s computer within the Content Viewer, and points the Web browser to the URL that you have specified. This is different than sharing a Web browser, because the participants can navigate the Web page independently. Participants can interact with the content on the Web page, or click links to navigate to other Web pages.

Sharing Web content is useful if you want participants to do something on the Web on their own, like filling out a training evaluation form.

To Share Web Content in Page

1. In the Session window, on the Share menu, choose Web Content in Page.

2. A dialog box will appear. Type a URL in the box and click OK. A new Web browser opens on each participant’s computer within the Content Viewer, displaying the specified Web page.
Sharing a Web Browser

Sharing a Web browser allows all training session attendees to view a Web page, and any interactions with the Web page. Attendees can also view any animation effects in a shared Web browser. Web browser sharing is useful if you want to take participants on a Web tour. The participants will follow along as the presenter navigates the Web. The presenter may want to take participants to a Web site where they can access additional resources, and demonstrate how to find information.

<table>
<thead>
<tr>
<th>Web Content Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Displays URL of current page</td>
</tr>
<tr>
<td>Display Full-Screen</td>
<td>Displays Web Page in Full-Screen view. Press ESC to return to Standard View</td>
</tr>
<tr>
<td>Attendee Statistics</td>
<td>Displays specifics of number of attendees synchronized with your display. Also lists number that are not and reason</td>
</tr>
</tbody>
</table>
While sharing a Web browser, you can allow an attendee to control it remotely. For example, if you share a Web-based application, you can allow an attendee to practice using the Web-based application. This is a good way to give attendees hands-on practice using an application. You can also annotate on a shared Web browser.

### To Share a Web Browser

1. In the Session window, on the Share menu, choose Web Browser.

![Web Browser menu](image)

2. Type a URL in the address box of the Web browser and press Enter. The Web page will display for all participants. The floating icon toolbar will also appear on the screen.

**To allow a participant to control the Web Browser:**

1. Click the Sharing button in the top right corner of the application.

![Sharing button](image)

2. Select Allow to Control Remotely.

3. Select the participant’s name. The participant clicks on the Web browser to gain control of the application. The presenter can regain control of the Web browser by clicking on the application.
To pause sharing the Web Browser:
1 Click the **Sharing** button in the top right corner of the application.
2 Select **Pause Sharing**.
   - **Note:** Pause Sharing is a security feature that temporarily prevents participants from viewing your mouse movements. It is recommended to use pause sharing when you are browsing to access materials on your computer. Participants will not see the location of the file on your computer, or the names of other files on your computer.

To resume sharing the Web Browser:
1 Click the **Sharing** button in the top right corner of the application.
2 Select **Resume Sharing**.

To stop sharing the Web Browser:
1 Click the **Sharing** button in the top right corner of the application.
2 Select **Exit Web Browser Sharing**.

**Sharing a Web Browser**

1 Select **Share Web Browser** and navigate to one of your favorite sites.
2 Ask one of your attendees if they would like to control the navigation throughout the site.
3 Pass Remote control to them and have them click on some links.
4 Click the mouse to resume control of web browsing.
5 Select **Stop Web Browsing**.
My Training Manager

My Training Manager allows you to share your training session as a presenter with attendees so they can see what you see. The presenter view and the attendee view are often quite different in a Training Center session. This feature allows attendees to “look over the shoulder” of the presenter. It is a great way to instruct on Training Center functionality without having to share one’s whole desktop.

You enable My Training Manager from the Share menu. The attendee will see the presenter view plus a sharing identifier at the top of the screen, indicating they are viewing the desktop of the presenter. A sharing menu allows the presenter to pass remote control, allow annotation, pause and exit sharing similar to share application or share desktop.

To Share My Training Manager

1. In the Session window, on the Share menu, choose My Training Manager.

2. The button appears in the top right corner of your screen and the appears at the bottom of the screen. Click on either one to access the sharing menu.

3. The sharing menu allows you to pass control to an attendee, start and allocate annotation privileges, set views for attendees, and pause sharing.
4 Attendees will see a Share Indicator title bar across the top of the screen. This helps them differentiate between your shared screen and their own screen.

To stop sharing My Training Manager:

1 Access the sharing menu from or .

2 Select Exit Sharing.

Summary

In this lesson, you learned how to share various types of information and give remote control to an attendee. You also learned how to annotate documents.

In Lesson 4 you will learn how to create and conduct polls in your training sessions. Before moving on, be sure to check your understanding of Lesson 3 by answering the questions that follow. The answers are provided on the reverse side of the Check Your Understanding page.
Check Your Understanding

1. When you Share a Presentation or Document, are you viewing your original document?

2. Can you share more than one document at a time?

3. Can you save or print information from your whiteboard?

4. Why would you want to use the Share Application feature?

5. What is the recommended screen resolution setting for conducting a training session?
Answers to Lesson 3

1. When you Share a Presentation or Document, are you viewing your original document?
   
   No, you are working with a copy of your document. When you open your document in the Content Viewer it is converted to a .ucf (Universal Communications Format) file.

2. Can you share more than one document at a time?
   
   Yes, you can share multiple documents. Each document name appears on a separate Viewer tab. Just click a tab to switch between documents.

3. Can you save or print information from your whiteboard?
   
   Yes, from the File menu you can select Save or Print.

4. Why would you want to use the Share Application feature?
   
   • Demonstrate or train participants on the use of an application
   • Collaborate on a project where participants can work on a live document.

5. What is the recommended screen resolution setting for conducting a training session?
   
   The lowest setting used by your participants. In most cases, the optimum resolution setting is 800 x 600.
Lesson 4: Polling

In this lesson, you will learn how to:

- Create a poll and save it for future use.
- Administer a poll and share results.
- Use the Poll Questionnaire Editor.

Polling Panel

The Polling feature allows the host or presenter to present a survey or questionnaire for all training session participants. Conducting a poll can be useful for gathering feedback or allowing participants to vote on a proposal or topic. By using the Polling feature, the presenter can keep participants engaged and focused on the material that is being presented. Polling can also be used as a knowledge check to ensure that participants are comprehending the material.

*Note:* To download the stand-alone version of the WebEx Poll Questionnaire Editor, click the Support link on your Training Center site navigation bar.

Creating a Poll Questionnaire

Before conducting a poll, you must first create a poll questionnaire. You can prepare a multiple choice or short answer questionnaire at any time during a training session. Or, to save time during a training session, you can create the questionnaire before the session's starting time - save it, then open it for use during the training session. You can create a poll outside of a Training Center session by downloading and installing the stand-alone version of the WebEx Poll Questionnaire Editor.

How to Create a Poll

1. Click on the Polling button in the icon tray at the top of your panels.

2. Choose from the following question types:

   - **Multiple choice**
     Single answer - displayed as radio buttons.
Multiple answers - displayed as check boxes.

- **Short answer**

3. Click **New** and type your question in the box.
4. Click **Add** to add an answer to the question.
5. Type an answer(s) to the question in the box.

6. Optionally, to edit a question or answer from the poll questionnaire, click the text, then click the **Edit** button.

7. To Delete a question or answer from the poll questionnaire, click the text, then click the **Delete** button.

8. To rearrange the order in which a question or answer appears in the poll, click the text, then click the **Move Up** or **Move Down** button to move the text up or down.
9  To display a check mark next to the correct answer, click **Mark as Correct**.

10 Choose **Record individual responses** to view individual responses to each question.

11 Click **Clear All** to clear the poll questionnaire from the polling panel.

12 Click **Yes** to save the poll questionnaire, or **No** if you do not want to save the poll questionnaire.

13 To specify a time limit to complete the poll questionnaire, click **Options**. The **Polling Options** dialog box appears.

14 Type the number of minutes in the **Alarm** box.

   **Note:** The Timer defaults to a time limit of 5 minutes.

15 Click **OK**. **When you open the poll, the timer starts. The poll will end automatically when the time limit is reached.**
Lesson 4: Polling

Saving & Opening a Poll

1. Click the **Save** icon on the Polling toolbar.

2. Type a name for the file in the **File Name** box and click **Save**.

3. To open a Poll, click the **Open** icon on the Polling toolbar.


5. Click **Open**.

   **Note:** The presenter can create or open more than one poll at a time.

Administering Polls

For participants to answer the poll questions, you simply click the **Open Poll** button. If you have set a time limit for responding to the poll, a countdown timer will appear at the top of the polling panel. Upon completion of the poll, the participants click the Submit button to send you the results.

Once the poll is closed, the presenter is able to view the results of the poll, and may choose to share the results with the participants. Poll results can be saved for detailed evaluation later. File types include .csv, .txt, or .htm/.html.

How to Open & Close Polls

1. Click the **Open Poll** button at the bottom of the **Polling** panel.

   **Attendees are prompted to take the poll by clicking the radio buttons, check boxes, or typing in a short answer.**
2 Once the attendee clicks the **Submit** button, the answers will be saved.

**Note:** If an attendee does not complete the poll questionnaire in the time allocated, a dialog box appears asking if they want to submit their answers now. They will have 20 seconds before the poll ends for good.

3 Click the **Close Poll** button on the bottom right hand corner of the **Polling** panel to close the poll.

**Sharing Poll Results**

1 Choose **Poll Results** from the **Share with attendees** section.

2 Click **Apply**. The Poll results box appears on participants’ screens.
To share correct answers with attendees:

1. Choose Correct Answers from the Share with attendees section.

   **Note:** In order to share correct answers with attendees, you must select Mark as Correct in the Answer section when creating the poll.

2. Click Apply. A check mark appears next to the correct answer for the attendee.

To share individual’s grades:

1. Choose Individual’s grades from the Share with attendees section.

   **Note:** In order to share individual grades with attendees, you must select the Record individual responses check box when creating the poll.

2. Click Apply. The attendee will see individual results in the Poll results window.

To share individual results with attendees:

1. Choose Individual Results from the Share with attendees section.

2. Click OK. The Attendee will see individual poll results in the Poll Results window.

<table>
<thead>
<tr>
<th>Q. What blend of coffee do you like best?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Answer</strong></td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attendees</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andrew Porter</td>
<td></td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>Cynthia King</td>
<td></td>
<td></td>
<td>*</td>
</tr>
</tbody>
</table>

To save poll results:

1. From the File menu, choose Save.

2. Choose Poll Results.

3. Type a name for the file in the File Name box and click OK.
**Poll Questionnaire Editor**

You can use a standalone version of WebEx Poll Questionnaire Editor to create or edit poll questionnaires without starting a training session. This allows you to create polls before a training session, saving time for other online activities. This editor is available as a downloadable link which you can access from the Support page of your Training Center site. The standalone editor looks just like the Polling Panel in a Training Center session.

**How to Download the Editor**

1. Navigate to your Training Center site.
2. Click on the *Assistance* link in the left navigation bar.
3. Click *Support* and scroll to the Downloads section at the bottom of the page.
4. Click *Download WebEx Poll Questionnaire Editor*. *The Editor will be downloaded to your computer.*
5. Launch the Editor and create and save your polls.

**Take a Survey**

1. Switch to the Polling Panel.
2. Create a poll with at least one multiple choice and one single answer question. *Be sure to select Record Individual Responses.*
3. Open the poll to attendees and have them submit their responses when they are finished.
4. Close the poll and share results with attendees.
Summary
The Polling feature is a powerful feedback tool for communicating with your participants in a Training Center session. Being able to create a poll on-the-fly or carefully structure questions ahead of time for participants is a valuable asset.

In this lesson, you learned how to create polls as well as administer polls and share results with your audience. Be sure to check your understanding of Lesson 4 by answering the questions that follow. The answers are provided on the reverse side of the Check Your Understanding page.
Check Your Understanding

1. List 2 of the 3 types of polling questions.
2. If you wish to use the same poll in another training session, how could you accomplish this?
3. How do you share individual participant results with others?
4. What is the easiest way to create polls outside a training session?
Answers to Lesson 4

1 List 2 of the 3 types of polling questions.
   - Single answer
   - Multiple answer
   - Short answer

2 If you wish to use the same poll in another training session, how could you accomplish this?
   Save the poll without the results. In the new training session open the poll file.

3 How do you share individual participant results with others?
   You must select the Share with attendees checkbox at the bottom of the Polling panel then click Apply.

4 What is the easiest way to create polls outside a training session?
   Use the WebEx Poll Questionnaire Editor.
**Course Review**

You have successfully completed the *Training Center 4: Facilitating Online Training* course. Using these new tools, you can now conduct interactive training sessions in WebEx Training Center. Using the Share menu to present content and the Panels to chat and ask questions, participants stay motivated and highly involved in your training. The added feature of Polling allows you to check their knowledge as well as survey their opinions.

You now have the skills to do the following:

- Confidently navigate the training session window
- Assign privileges for attendees
- Communicate with your participants
- Successfully present information in a training session
- Create and conduct polls

For additional support, check out the list of resources below.

**Post Training Support**

**Distributed Materials**

Your WebEx instructor provided:

- PDF file of the Participant Guide
- Training Center Job Aids

**Additional Resources**

- **WebEx University** offers live, interactive training sessions and self-paced training programs for all WebEx services. To view the course offerings, course schedule, and register for courses, visit: [http://university.webex.com](http://university.webex.com).

- **WebEx Support** is available 24 hours a day, 7 days a week.
  For further assistance, please visit WebEx Support at [http://support.webex.com](http://support.webex.com)
Get the Ball Rolling!

Ready, Set...

1. Make sure you have a ‘Host Account’ on your company’s WebEx site. If not, please contact your WebEx site administrator to obtain your Host account.

2. Navigate to your company’s WebEx site. Your site name will be in the form - http://yourcompanyname.webex.com

3. Click Log In and enter your user name and password.

4. Schedule a Training Center session and invite a colleague.
   - Click Schedule Training under Host a Session
   - Enter a session topic, password and select a teleconference option
   - Click List Attendees under Attendees to invite attendees.
   - Click Schedule then click OK.

Go! Start that Training...

1. Click My WebEx > My Meetings, locate your session and click Start.
   Note: You can also open the session by clicking the session link from your confirmation email.

2. Communicate with your attendees. Use Chat, Q&A, Feedback tools and Emoticons.

3. Use the Share menu and select Presentation or Document to share a document in the training session. You may also want to try out your new skills with some of the following tasks:
   - Share an application and your Web browser
   - Share Web content and your desktop
   - Allow Remote Control
   - Pass the Presenter Ball
   - Take a poll
   - End your training session

Refer to your Participant Guide to assist you with these fundamental tasks.

Best Practices to consider in your transition:

- Practice, Practice, Practice. Experience builds confidence.
- Schedule additional time in your first few sessions to help the group acclimate to the WebEx environment.
- Provide attendees with a quick tour and guidelines for communicating within the meeting.
- Collaborate with voice and visual data simultaneously.
- Let attendees interact with your documents.
- Make effective use of time by sharing applications, using annotation tools, and transferring files.

Next Steps:

- Attend *Training Center 4 Foundations: Scheduling, Testing, & Reporting* by registering at [http://university.webex.com](http://university.webex.com)
- Attend additional WebEx instructor-led and self-paced training sessions.  
  [http://university.webex.com](http://university.webex.com)